
Aurora HDR 1.0 user guide 

Welcome to Aurora HDR! 

Aurora HDR is a joint project between Macphun and Trey Ratcliff to produce the finest 
HDR software in the world. 

Macphun is one of the world’s leading developers of consumer and professional 
photography software, serving over 30 million customers worldwide. All of the 
company’s software is made exclusively for Mac. 

Trey Ratcliff is a photographer, artist, writer and adventurer with over 14 million fans 
around the world who regularly follow his exploits and seek photographic education 
and inspiration from his work. He is one of the world’s pre-eminent HDR 
photographers, his images have been viewed on the Internet over 115 billion times. 

Using Trey’s vast experience with the current tools in the market, and advanced 
technology from Macphun, we have jointly created state-of-the-art software to help 
photographers of all skill levels make amazing images. 
  
Aurora HDR will contain every imaginable tool needed to produce high-quality “next 
generation” dramatic images, as well as Presets and video Training developed by Trey 
that will appeal to every photographer. Two versions will be available - a “standard” 
version available on the Mac App Store, and a “Pro” version available simultaneously 
on the Stuck in Customs and Macphun websites. 

__________________________________________________ 

What is HDR? 

High Dynamic Range (HDR) photography is a popular photographic technique 
designed to overcome the limitations of image sensors in digital photographs. This 
process utilizes multiple exposures of the same subject, each shot at different 
exposure values (“brackets”). Those are then automatically merged into a single shot 
which encompasses a greater exposure range. 
__________________________________________________ 



Key features and benefits of Aurora HDR  

• Revolutionary HDR algorithms. Get natural, high quality results in no time.  
• Total HDR editing experience with the most complete set of tools available. 
• Powerful one-click presets, including Signature Pro presets by Trey Ratcliff. 
• Layers, masking and brushes provide the ultimate in selective editing. 
• Unique Radiance controls and custom texture blending for creative versatility.  
• Detail enhancement to increase drama in images. 
• Extensive color and toning controls for vibrant color combinations. 
• Approachable user for a comfortable, understandable experience. 
• Built-in sharing supports popular photo communities and social networks. 
• RAW, JPG, TIFF and other popular files support for the greatest flexibility. 
• Standalone app or a plug-in to Adobe Photoshop, Lightroom, Apple Aperture. 

 



Starting with Aurora HDR                                
  

Image upload 

Aurora HDR can upload series of images shot with different exposures. A series of 
images with different exposures is commonly known as HDR bracketing. The basic 
version supports up to 7 images in an HDR bracket; Aurora HDR Pro supports up to 14 
images in a bracket. In addition, all versions can open just a single image. 

The app supports following image file formats when opening: 
1. Basic version: JPG, TIFF, PNG 
2. Professional version: JPG, TIFF, PNG, RAW formats.  

The open dialog allows you to open a set  
of sample images or of course use your own. 

When you select an image or images, you will see a preview window with the 
images you plan to process. You’ll also be able to select a variety of auto 
enhancements: Alignment, Ghost Reduction and Chromatic Aberration Reduction. 

!  



HDR Image Assembling Parameters 

Alignment 

If the photos from HDR bracket were taken without a tripod, by hand, they may differ 
slightly. If the Alignment option is enabled, the application automatically aligns all the 
images before HDR assembly. Therefore, Aurora makes it easy to use images from 
HDR bracket, even those shot without a tripod. If you open an image from the HDR 
bracket without Alignment and it is slightly blurred, try to open it again with the 
Alignment option enabled. 

Ghosts Reduction 

If there are moving objects in your HDR brackets — tree leaves, flags, people, etc. — 
it can look a bit unusual after HDR assembly. The moving object may appear as a 
translucent ghost. This is simply because the image information is different (moved) 
on each different HDR bracket image. To minimize this problem, enable Ghosts 
Reduction. This function will analyze the images and create an HDR image with a 
static object whose position is selected from one of the images of the bracket.  

__________________________________________________ 

ATTENTION! 

This option considerably slows down the creation of HDR because it requires 
significant computing resources to analyze the images. In addition, it is worth 
considering that this function may not always work properly because of lack of 
information to obtain a static image from a moving one. Keep this option off and turn 
it on only when you need to fix apparent problems with the ghosts. 
__________________________________________________ 

Chromatic Aberration Reduction (only in Aurora HDR Pro)  

This parameter analyzes images and minimizes detected chromatic aberrations. These 
are typically characterized by a slight red glow present in stark contrasting areas in 
the image. These optical aberrations are always present on any photo and can reduce 
picture quality. This is important if the snapshot has to meet high professional 
standards. 



User interface overview                                  

Working panels overview 

Aurora HDR UI consists of 4 operating areas 

Top Toolbar. There are general-purpose functions to operate with the application. 

!  

Info panel. It is used to display information about the image, as well as functions to 
work with a brush and a mask layer in a Mask Layer Mode. 

!  

Sidebar.  
The main workspace. There 
are all tools and layers there. 

Bottom panel.  
Displays presets. 

!  



Top Toolbar overview 

There are the main basic application functions in the Top Toolbar. They are grouped 
into logical groups for easier use. Consider these groups from left to right.  

1. Open / Export Buttons.  
The first button is used to load new images for processing. The second button is 
used to export an image from the application and save it as a graphic file. The 
same image can be uploaded directly to social networks and other online 
services. 

!  

2. Zoom Buttons.  
These buttons are used for manipulating the image size in the workspace. If 
you go from left to right the buttons do the following. 

1. Increase the image up to 100% 
2. Fit to screen - the image size will be reduced to cover the entire working area. 
3. Zoom the image closer 
4. Reduce the image 

!  

3. Comparison Buttons.  
These buttons allow you to compare the original image with the original default 
image, so you can easily compare how your enhancements changes the original 
image.  

The buttons do the following: 

Eye - Quick Comparison Button. If you hold down the button, the original image is 
displayed in the workspace instead of the enhanced version. This allows you to quickly 
compare the current image with the original. This is the fastest and most convenient 
mode of comparison. Press the spacebar as a keyboard shortcut to apply this function. 
Simply push and hold "spacebar" for a quick comparison. 

Shutter Comparison Button. This button activates a comparison where the image is 
divided by a vertical strip. The original image is displayed on the left, and the current 
result is on the right. This vertical strip can be moved left and right, so you can view 
the differences in the picture. 



4. Undo / Redo Buttons.  
Undo Button (left arrow) cancels the last action (for example, changing the 
slider), and the button Redo (right arrow) returns the last undo function. 

!  

5. Crop, move, brush, layers, histogram buttons.  

!  

Crop Button.  
Turns on the picture Cropping tool. This feature allows cropping the picture as well as 
to align (straighten) the horizon in the image if that is not horizontal. 

Move/Brush modes.  
Only one operation mode can be turned on. 

Hand icon mode means that we can move the image to view when in a zoomed-in 
state. This is the default mode when the software opens. To operate this mode, move 
your mouse over the main image, then press and hold the mouse to move the image 
on the screen. 

Brush icon mode will allow you to draw a layer mask on the current layer. In this 
mode, we work with a brush to paint the layer mask. By clicking and holding the left 
mouse button on the image we start to draw in the current layer mask. This mode is 
called Drawing. 

When you click on the icon that looks like stacked horizontal rectangles, the 
Layers Operating Pane is shown or hidden in the sidebar. 

When you click on the button with the histogram icon, the histogram is displayed or 
hidden in the sidebar. 



Info panel overview 

If the button with a brush is turned on, this bar turns into a Drawing function panel. 
Operations with drawing functions panel are provided in the Drawing and masking 
layers section. In this section we describe the Information Bar features in the 
navigation or adjusting mode. 

Left InfoBar Section 

!  

Information about the shooting parameters of the current HDR image is displayed 
here. This information is divided into several sections. Section displays the following 
information (from left to right): 

1. The indicator of the current HDR dynamic range. This indicator shows the EV of 
the darkest bracket, then the EV of the middle bracket and finally the EV of the 
brightest bracket, each separated by an ellipses. 

2. The number of images used for the assembly of the HDR. 
3. ISO, with which the image data was captured. 
4. The focal length when shooting brackets. 
5. F-stop for the images from this bracket. 

Middle InfoBar Section  

!  

This indicator shows the current zoom. When you click on the arrow "down" in the 
right side of the button you can select the preset modes to increase a given picture. 
You can also click in the percent field and type in a specific zoom percentage; press 
Enter on your keyboard to initiate the zoom. 

Right InfoBar Section 

The right InfoBar section displays the current resolution of the image in pixels as well 
as the number of bits per pixel. Aurora HDR operates in 32-bit per pixel mode to 
provide the highest image quality. 

!  



Preset panel review  

Functions and features to operate with presets   

Presets allow you to make instant changes to your HDR image with the click of a 
button. Each preset is made up of all the saved settings (sliders) located in the right 
sidebar. For each layer, a different preset can be applied, which can make for some 
creative results! 

Clicking the Preset button shows/hides a “filmstrip” panel at the bottom of the 
application which displays the image preview of each preset available in a given 
category. Clicking on the drop-down menu below the Presets bar reveals the 
categories. 

To select the current preset in the lower panel, simply click on the preview image and 
all the preset settings of the current preset immediately is applied to the image. An 
orange frame highlights the current preset. To view all the presets you can flip the 
image presets horizontally. 

!  



Preset panel functions 

1. The "Presets" button with an star in the upper left corner displays and hides the 
presets filmstrip bar on the bottom of the window. 

2. “+” Upper right button creates a new user preset, saving the current state of all 
the sliders in the "Tools" sidebar. Enter a name for the new preset. 

!  

3. Top right button with two arrows circling each other. This button resets all 
sliders in the "Tools" sidebar to their default state. Thus, you can quickly reset 
all changes.  

4. The big drop-down arrow button on the bottom displays a window with a grid of 
preset categories. The current category will be highlighted and will also be the 
name of the category (e.g. “Basic”, “Indoor”, etc.). As stated before, the 
filmstrip will contain previews for each of the presets in the chosen category. 



Preset Categories  

There are default and user presets: 

1. Default presets are those that came originally installed into the application. 
2. The user presets are created by the user. 

Application preset categories: 

1. Basic - is a versatile built-in presets suitable for all kinds of images. 
2. Architecture - suitable for architecture, cities, and urban landscapes. 
3. Landscape - suitable to the nature and landscapes. 
4. Indoor - suitable for shooting of interiors as well as objects. 
5. Dramatic - a set of creative presets for stylized photos.  
6. Trey’s presets – signature presets by Trey Ratcliff.  
7. Favorites - a set of presets that were listed in the favorite or selected. 
8. User - is a set of user-created presets. 
9. All - a category includes all the presets in alphabetical order.  

More with Presets 

1. Add to your favorite or chosen presets  
To highlight any preset as a favorite, click on the star in the top right corner of 
the image preview presets. It will change color to bright yellow. Re-click on the 
star to de-select the preset as a favorite. 

!  

2. Additional capabilities for user presets  
There are additional features for user presets that are not available for the 
built-in presets. To access the context-sensitive menu for a user preset, click on 
the right button of the mouse on the preset image. 



!  
  

• Show in Finder. Open a Finder window with the currently selected preset file. 
This allows you to copy the preset and pass it on to someone else. 

• Delete. Delete the current user preset. 
• Rename. Rename the current preset.  
• Export. Save the current preset file to a location of your choice. 
• Update with Current Settings. To over-write or re-save the preset with the 

current state of the sliders in the sidebar. 



Export and Import of Presets 

You can freely export your own presets  
and import another person’s presets into your application. 

Select the menu item "File -> Show Presets Folder." which displays the folder with the 
current preset of the application. From there, you can easily add files (presets) from 
to this folder. All presets in this folder appear in the User category and the All presets 

• To export, you can simply copy files from this folder. 
• To import, just copy the files into the new presets folder. 
• To delete a preset, you can simply delete the preset file in the folder. 

A New User Preset Creation 

• To create a new custom presets, press the "+" in the sidebar. 
• After clicking on the button, enter the name of the new preset. The newly 

created preset appears in the "User Presets" category and in the "All Presets" 
category. 

!  



The Right Sidebar 

The right panel is where you’ll find all of the major features and tools to help you 
create amazing HDR images. 

This sidebar is divided into 4 sections (from top to bottom): 

1. Histogram - Displays a histogram of the current image. 
2. Layers - All functions to work with layers. 
3. Tools - Includes all the primary tools and features for enhancing images. 
4. Presets - This panel is described in detail elsewhere in this manual. 

!  



Image Processing Toolbar   

The Tools section of the sidebar contains 13 control panels which allow you to achieve 
the best possible image results. Each of the panels contains sliders and controls 
related to the Tool. 

!  

Aurora HDR contains the following tools: 

• Tone Mapping - General settings related to the Tone Mapping and compression. 
• Tone - Adjusts the tone of the image as well as its contrast. 
• Structure - Strengthens the structure, details and micro-contrast of the image, 

leading to a more “crisp” image. 
• HDR Denoise - Reduces noise and artifacts in the image created by the HDR image 

merge process, as well as making the overall image smoother. 
• Image Radiance - Provides for an overall “dreamy” look to your image by softening 

image luminescence, and increasing contrast & saturation. 
• Color - Color settings such as saturation, temperature and tint. 
• Details - Increases image clarity. 
• Glow - Provides a glow effect to the image, primarily in highlights. 
• Top & Bottom Lighting - Provides the effect of separate exposure adjustments in 

the upper and lower areas of the image. 
• Tone Curve - Represents the tonal range of the image along a diagonal line which 

can be adjusted by clicking and dragging. 
• Color Filter - Adjusts the saturation and brightness of a particular color channel. 



• Color Toning - Shadows and highlights color tinting for stylized visual effects. 
• Vignette - Provides a vignette effect for finishing images to a professional level. 

How to use the Image Processing Toolbar Section 

Each tool is a separate section. Each section consists of a header with the name of the 
tool and a set of sliders related to this tool. 

Common Actions with the Tool section include the following: 

• Clicking on the header (the section name) hides and reveals this section. 
• Clicking on the orange circle to the left of the section name enables or disables the 

tool, allowing you to view the image without the effect of this tool. 
• When the cursor is on the title icon, an icon with two arrows appears. When you 

click on this icon, all the sliders of this section are restored to their default state. To 
cancel this action, you can click the "Undo" button. 

!  



Image Processing Toolbar in Details              

Tone Mapping 

This tool gives you control to adjust the Tone Mapping process. Tone mapping (or 
“compression”) converts the wide dynamic range image into one that is more narrow 
and can be displayed on a computer monitor.  

Note: The tool is available only on the first layer! 

!  

Sliders Description 

Spectrum  
Image lighting effect setting. This is not just exposure, but includes a special ability to 
configure balanced image brightness without getting completely white or completely 
black areas. The overall brightness of the image increases when you move the slider 
to the right, while moving the slider to the left lets you decrease the overall brightness 
of the image. 

Spot Lighting  
Range of illumination setting. When you move the slider to the right there is the effect 
of increasing the detail of the image by a smaller backlight of details. At the same 
time, more expressed effects of small contour glow (halo) appear and the image can 
become less realistic. If you move the slider to the left, the image is little more flat 
and realistic, but halo almost completely disappears. 

Final Touches  
Spot Lighting effect adjustment slider. You can change image lighting options with this 
slider. When you move the slider to the right, you’ll get a more realistic result. When 
you move the slider to the left, the image is more detailed. 

Tool Remarks 
This effect is minimized by default to present a realistic result right from the start. In 
most cases you need not change these sliders. However, if the image has complex 
lighting and some improvement of its overall visual look is required, these sliders are 
necessary. 



Tone  

This section is responsible for the overall tone setting of the image. Image processing 
should always start with this tool. 

!  

Sliders Description  

Smart Tone  
This slider adjusts the overall brightness of image properly. When moving to the right, 
the image is more vivid, but it does not work when bright areas become white, as in 
the ordinary exposure. And when you move the slider to the left, the image becomes 
darker but there are no completely black areas. 

Highlights  
Adjusts the brightness of the brightest areas of the image. Moving the slider to the 
right cause very bright areas to become brighter, while moving the slider to the left, 
makes them darker. 

Midtones 
Adjusts the brightness of mid-tones in the image. Many of these colors are not the 
most vivid, so they are closer to the dark side of the spectrum. When moving to the 
right such tones become lighter, while moving to the left they get darker. 

Shadows  
Adjusts the brightness level of the darkest areas of the image. Moving the slider to 
the right will cause such areas to become brighter and additional details will appear. 
When moving to the left, such areas become darker, and the number of shadow areas 
in the image generally increases.  

IMPORTANT! If you greatly increase the lighting of Shadows, that image will be 
much softer. 



Whites  
Adjusts the white point of the histogram and white tones in the image. When moving 
to the right, the brightest tones will become brighter while the histogram stretches to 
the right. Moving the slider to the left will cause white tones in the image to become 
darker and the histogram to compress to the left. 

Blacks  
Sets the black point of the histogram or black tones in the image. Moving the slider to 
the right, black tones become brighter and the histogram compresses to the right. 
Moving the slider to the left, black become darker and the histogram stretches to the 
left. 

Contrast 
Adjusts the contrast of the image. Contrast is the difference in luminance or color that 
makes an object in an image distinguishable from another. Practically speaking, 
contrast is determined by the difference in the color and brightness of an object in 
relation to other objects within the same field of view. 

Tool Remarks 
Whites and Blacks can be used to fine-tune of contrast of the image. 
Strong raised Shadows can lead to a strong dark areas flashing and loss of contrast. 

A recommended workflow is to start with Smart Tone, then proceed to setting 
Shadows, Highlights, Midtones and finally adjust the contrast of the image using 
the Whites, Blacks, Contrast. 



Structure 

This tool allows adjusting of image detail and clarity. Using this tool you can get a 
classic HDR effect with great detail or get a smoother picture with less detail. This is 
the main tool to increase micro-contrast of the image and visualize more details in the 
image. 

!  

Sliders Description  

Clarity 
Adjusts the overall image clarity. By increasing the value of the slider, the number of 
global visible components increases. If values are much larger, halos may appear on 
the contrast edges of the image. Best practice is to not raise the value of the slider 
above 50. 

HDR Look Section  
Increases image detail by revealing of the structure and texture of the surfaces in the 
image. This micro-contrast enhances the image and hidden details appear. 

• Amount - The strength of the effect. By moving the slider to the right, the 
amount of visible detail in the image increases. Moving the slider to the left will 
cause the image to lose detail and flatten. The “zero state” in the middle means 
that the amount is not applied by default. 

• Softness - Controls the overall softness of structure and textures in the image. 
Moving the slider to the left will cause parts of the image to become less 
smooth and more unrealistic. This produces the so-called classic view of the 
HDR effect. Moving the slider to the right, on the contrary, the details become 
more global and the image is more realistic. This is very useful slider to adjust 
realistic details. 



• Boost - Adjusts the overall display of details. When moving the slider to the 
left, the images will become more realistic and “calm." Moving the slider to the 
right will accentuate details and make the image more unrealistic. 

HDR Detail Section  
This section amplifies micro-detail of the image. These are small details that form the 
surface of any object in the image. They can further enhance details of the image and 
provide a more vivid artistic HDR effect, however it can also make the image very 
noisy. 

• Amount - Increases micro-details and contrast. 
• Softness - Affects the general "softness" and realism of the photo. Moving the 

slider to the left will cause the image to become very finely detailed and 
unrealistic. 

Tool Remarks 
Increasing the values of detail can cause the growth of noise in the image. 
In case of high Clarity values, ghosting of the image may appear and so we do not 
recommend raising the value above + 50. 

In most cases, HDR Detail adds a lot of noise in the image. To get a realistic HDR, do 
not apply HDR Detail 



HDR Denoise 

This tool blurs the image and reduces the amount of noise and any image artifacts 
caused by merging multiple exposures together. It can be used to reduce the amount 
of noise which may have been caused by increasing detail within the HDR Structure 
section. It’s safe to say this tool has the opposite effect on an image in relation to the 
Structure - it reduces the amount of detail. 
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Sliders Description  

Amount  
The strength of reduction of small noise in the image. Moving the slider to the right 
will increase the noise reduction. Note: the Opacity slider must be moved above 0 to 
notice results. 

Smooth  
This slider allows you to make the image more blurred which has the effect of creating 
a less detailed and noisy image. This is a very aggressive effect. 

Opacity  
Relates to the transparency of this effect. Moving the slider to the left removes the 
impact of noise reduction, while moving to the right allows the full effect of the de-
noise control to be shown. 

Tool Remarks 
It’s helpful to apply this tool not to the entire image, but locally: Create a layer in 
which you’ll apply the effect, and then, using a mask, brush only the area where the 
effect should be applied. For example, if the noise is very noticeable in the sky, then, 
using a mask, apply the effect to the sky. This effect should never be applied to the 
entire image - otherwise too much detail will be lost. 

It is better to leave a little transparency effect that preserves a little noise in the 
original image to increase its realism. Best Opacity value is in the range of 70 to +90. 

The effect can also be used for aggressive blurring of local areas in the picture, such 
as the sea or a flowing stream of water. It will make them softer. 



Image Radiance 

This tool provides a soft glow effect to the image, adding more vibrant colors with an 
increased global contrast. Moderate use of Image Radiance can give you a more 
interesting, entertaining “dreamy” images. 
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Sliders Description  

Amount. Effect strength. For a moderate effect and a more realistic image, keep the 
values in the Amount to +40. If the Amount value is 0, then the effect is not applied. 
Move the slider to the right to increase Amount. 
Smoothness - Controls the softness of the effect. 
Brightness - Controls the brightness of the effect. 
Smart Colorize - Adjust the color saturation effect applied to the image. 
Warmth - Adjust the hue of the effect. 

Tool Remarks 
At a low setting, this effect will give the image more contrast and can increase color in 
the image. Use the Smart Colorize slider for better control. 



Color 

The Color section gives you complete control  
over colors and color saturation of the image. 
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Sliders Description  

Saturation. Adjust the color saturation of the image. This is a standard slider, similar 
to many other applications. Moving the slider to the right will cause the colors in the 
image to become more saturated, while moving the slider to the left will cause the 
picture to become black and white. 

Vibrancy. This slider is a "Smart Saturation” control. In general, its effect is similar to 
Saturation with the difference that it increases less vibrant colors stronger and has a 
weaker effect on more vibrant colors. This allows you to get more realistic and less 
saturated colors the picture. This slider can be used in conjunction with the Saturation 
to enhance the secondary colors. 

Color Contrast. Enhances the color contrast in the image. Color contrast specifically 
refers to contrast that is created between differences based on colors (vs. luminance). 

Temperature & Tint. Sets the color temperature of the image. If the overall tone of 
an image is too warm or cold, it can be changed using these sliders relative to the 
color spectrum shown on the sliders. 

Tool Remarks 
Vibrancy сan be used in conjunction with Saturation to make secondary colors pop a 
little more. Active application of Color Contrast is also recommended to obtain realistic 
contrast and color saturation of the picture. This slider is very helpful. 



Details 

This tool allows you to control the details of the image, making it more clear and 
sharp, or vice versa, softer. This tool is useful for improving the overall quality of the 
image as well as to increase the quality of the images that will be used in high 
resolution, such as for printing. Increasing the sharpness can also compensate for 
lower quality optics used to make the captured image.  

Innovative technologies allow the Details tool to improve image sharpness without 
increasing digital noise or creating unnatural ghosting or halos in the image. This is a 
very powerful tool to improve the quality of images. 
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Sliders Description 

The tool has 3 tabs with the same set of sliders. 

Global 
Sliders in this tab control the details of the entire image. 

Highlights 
Sliders in this tab control those parts of the image that are only on the brighter side of 
the tonal range in the image. The rest of the image remains intact. 

Shadows 
Sliders in this tab control parts of the image that are in the darker side of the tonal 
range, without affecting the brightest tones in the image. 

Each tab contains the following sliders. 

Small sets sharpness of fine details. At 0, the effect is not applied. Moving the slider 
to the right will intensify the clarity of small details, while moving to the left, on the 
contrary, somewhat washed out the fine details. 

Medium sets medium-sized parts sharpness. At 0, the effect is not applied. Moving 
the slider to the right increases the sharpness, while moving the slider to the left - 
decreases it. 



Large sets sharpness of global contours of objects in the image. At 0, the effect is not 
applied. Moving the slider to the right increases the sharpness, while moving to the 
left - decreases. 

Masking is a separate slider. This slider controls the zone of detail amplification. 
When moving the slider to the left, the number of zones increases and the image 
becomes more detailed. When moving to the right, the number of granularity zones is 
reduced. Optimal masking comes from a setting in the range from 30 to 70. 

Tool Remarks 
A moderate increase in Small and Medium has positive impact on the sharpness and 
quality of any image. There is often no need to demonstrate all details in the image.  

In bright areas, such as the sky and light clouds, unnecessary detail will reduce 
realism. The dark areas often need more detail. Therefore, it is always better to 
strengthen Details in the shadows than lights. 

Tip: you can reduce the sharpness in bright colors by moving the slider to the left side 
of the Details in Highlights tab and increase the amount of detail in dark colors by 
moving the Details sliders to the right in the Shadows tab. The best way to increase 
sharpness is with Small and Medium details sliders. It is often not necessary to work 
with Large Details. 

Should you desire an image that is soft, you can achieve that effect by moving the 
Detail sliders to the left.  By default all sliders are at 0 and at that setting have no 
effect. The effect is only visible after moving sliders to the left or right. 



Glow 

The Glow tool adds auras on the picture. The effect finds the brightest areas of an 
image and adds bright halos to it, having the effect of shining. This effect can be used 
to give the photo a "romantic" view or create a fog effect. This effect looks good on 
night photos to accentuate glow halos around light sources.  
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Sliders Description 

Amount 
Sliding this control to the right increases the strength of the glow around areas of high 
brightness. 

Smoothness 
This slider controls the size of halos around bright areas. Moving the slider to the right 
increases the size of the halos. 

Brightness 
This slider analyzes the image and determines where halos will be created, letting you 
choose those areas of brightness that should be lightened up. Moving the slider to the 
left ensures areas of maximum brightness will be selected. This locates the glow just 
around the brightest areas. Moving the slider to the right will include darker areas to 
glow. Moving it all the way to a value of 100 will light up the entire image. 

Warmth  
By default, a neutral white color is used for the glow in the middle of a halo. This 
slider allows you to select a specific hue for the glow, according to the cool-to-warm 
spectrum shown on the slider. 

Tool Remarks 
This effect can be a powerful tool for creative photo processing. When you move the 
Brightness slider to 100 and increase Amount, you get a misty effect in the picture. By 
increasing the Amount, detail in bright areas is not lost, but rather “highlighted.” 



Top & Bottom Lightning 

This tool is a simulation of an analog filter to specify different brightness in the picture 
vertically - Graduated Neutral Density Filter. This effect is widely used in landscape 
photography. The effect flexibly and separately controls the brightness of the top and 
bottom of the image. This enables you, for example, to lower the brightness of the 
sky and raise the brightness of the foreground. Thus, your image can be significantly 
improved without resorting to creating layers and masking. 

!  

Sliders Description 

Top - controls the brightness of the top part of the image. Moving the slider to the left 
will make it darker and to the right brighter. 

Bottom - controls the brightness of the bottom part of the image. Moving the slider 
to the left will make it darker and to the right brighter. 

Blend - the transition bandwidth between the Top & Bottom. Moving the slider to 
the right will increase the Blend value, making the transition between the values of 
Top to Bottom wider. Moving the slider more to the left will decrease the blend value 
creating a sharp transition between Top and Bottom. Handy guidelines will appear on 
your image to visually show you the transition blends. 

Shift - Using this slider will adjust the vertical location of the transition zone between 
Top and Bottom in the photo. 

Rotation - Moving this slider rotates the transition zone. 

Tool Remarks 
This tool is best suited for landscape shooting with a strong horizon line. With it, you 
can lower the brightness of the sky at the top, and then, using Shift / Rotation / Blend 
orient the strip of brightness transition between heaven and earth approximately at 
the level of the horizon. 



Tone Curve 

This tool is a simple "Curves" that is present in many other applications. It can help 
you fine-tune the brightness and contrast of the image. 

!  

Parameters Description 

Customizable tabs to switch curves are at the top. At the bottom there are sliders that 
let you adjust black and white points of the histogram (the leftmost and rightmost 
sliders), as well as the middle bend of the curve (the central slider). 

Tool Remarks 
Turn to the articles available on the Internet for information on using the tool. This is 
such a broad topic, that one can write an original book. And there are a lot of them. 



Color Filter 

This tool allows for separate adjustment of the saturation and brightness of the main 
color channels in the image. 

!  

Sliders Description 

There are 2 tabs present in the Color Filter panel. 

Saturation - a set of sliders to adjust color saturation. The farther to the right the 
more intense color is obtained. 

Luminance - set of sliders to adjust the brightness of the colors. The further to the 
right the brighter is the color on the image. 

Tool Remarks 
This is a powerful tool for fine-tuning of colors in the image as well as a means for 
creative image processing. Examples of using this tool.  

• The sky is mostly blue in the photos. Therefore, lowering the brightness of blue 
colors in the image can cause more dark and deep blue of the sky. 

• Reducing the tone for some colors (move the slider to the right in Saturation tab), 
and leaving it for the other can cause a dramatic effect on the selective color in 
photos. 

• Raising the yellow color (move of the slider to the right) can significantly improve 
color saturation of autumn foliage on the photos. 



Color Toning 

This tool affects the color toning of images. The color shade in the Highlights area is 
for the light areas in the image and the Shadows area color shade is for the dark 
areas. The effect can significantly increase the visual appeal of images, and is often 
used for creative artwork. 

!  

Sliders Description 

Highlights Section - Sets the color for the bright colors in the image. 

• Tint.  
Shade selection. The slider movement to the left and right will change color 
based on the slider spectrum shown. Whatever color you’ve selected appears in 
a colored rectangle on the left of Tint. You can also click on the color rectangle 
and a Color Picker window will appear. 

• Saturation.  
This slider lets you choose the saturation level of the Highlights color shade. If 
the value of saturation = 0, white is used and toning is not noticeable. 
Therefore, to use color, you must choose both Tint and Saturation. 

• Protection. 
This slider controls how white colors in the image are toned. The Protection 
value 100% ensures whites remain whites. The Protection value 0% completely 
tints the whites in the image in the selected color for highlights. Anyplace in-
between adjusts the value of color appropriately. 



Shadows - Sets the color for the dark tones in the image. 

• Tint.  
Shade selection. The slider movement to the left and right will change color 
based on the slider spectrum shown. Whatever color you’ve selected appears in 
a colored rectangle on the left of Tint. You can also click on the color rectangle 
and a Color Picker window will appear. 

• Saturation.  
This slider lets you choose the saturation level of the Shadows color shade. If 
the value of saturation = 0, white is used and toning is not noticeable. 
Therefore, to use color, you must choose both Tint and Saturation. 

• Balance. 
Sets the balance between light and dark tones. If you move the slider to the 
right, more tones are considered bright and therefore the color chosen for the 
bright areas (Highlights) are emphasized in the photo. Move to the left and 
more tones are considered dark and the color chosen for dark tones (Shadows) 
are emphasized in the photo. Thus it is possible to balance what color you want 
to have for toning the image. 

• Amount. 
Adjusts the power of the effect. 

Tool Remarks 
The best results are achieved if you use the opposite colors to the bright and dark 
areas, for example: yellow and blue, green and purple. 

Use warm tones for light colors and cool ones for the shadows. Only light or only dark 
areas of the image can be toned. To avoid toning of certain areas, simply set Shadows 
or Highlights saturation parameter to 0. The color is not applied. 



Vignette 

A Vignette darkens or lightens the edges of your image. This is quite an old technique 
to emphasize the accents on photos. The effect typically leaves the central area 
unaffected while the edges are shaded or lightened. Aurora HDR goes further by 
letting you place the center point of the vignette anywhere in the image you like. 

!  
  

Sliders Description 

Amount 
Strengthens the darkening around the edges of photos. In position 0, the effect is not 
applied. Move the slider to the left side of the picture to give more shading to the 
edges, while moving the slider to right will brighten the edges. 

Size  
Size of the obscured area. Moving the slider to the left will increase the area of 
darkening. Moving the slider to the right will reduce the area of darkening. 

Roundness  
This slider changes the shape of the shaded area. 

Feather 
This slider sets the smoothness of the transition between the area of shading. 

Inner Light 
This slider increases the brightness in the central region which is not affected by 
shading. It allows you to create a contrast effect. 

Place Center Button  
This control adjusts the center of the effect. By default, the center of shadowing effect 
is in the center of the image. With this button you can shift the focus from the center 
of the image to any other place. Click on the button Place center which will turn the 



cursor into a “target sight.” Click this anywhere on the image to set the new center of 
your shading effect. 

Reset Center Button  
This button sets the center of the effect back on the center of the photo. It is 
necessary, if we shift the center of the effect to a different place and we want to set it 
back to the center of the photo. 

Tool Remarks 
This tool allows you to highlight key points in the photo, making it more interesting. A 
slight edges shading always provokes the viewer's eye to consider the lighter central 
part of the photo. You can also move the center to focus attention on some objects 
that are not in the middle of the picture. For a realistic picture, don’t lower the 
Amount below -50. As a rule, this effect is used only with darker shading. Highlights 
are rarely used except for some vintage looks. 



Working with layers                                         

Layers 

Layers are a powerful way to “build up” your images, with different enhancements and 
use of blending modes on each layer. 

!  

• To create a new layer. Click on the "+" button in the Layers Toolbar header. 
• To remove the layer. Select the layer and click "-" in the Layers Toolbar title. 
• To change the blending mode of the layer. Set Layer blending mode in the drop-

down list under the word Layers. You cannot set the blending mode for the first layer 
because it is not mixed with anything - it is the baseline image.  

Modes of blending: 

1. Normal 
2. Hard Light 
3. Soft Light 
4. Overlay 
5. Multiply 
6. Screen 
7. Luminosity 
8. Color 

Layer Transparency Setting. Click on the drop-down menu with percentages near 
the word Opacity. Press this button and move the slider to customize the opacity. 

Access Advanced Settings and Functions of the Layer. Click on the button with 3 
horizontal strips (down arrow) right of the tool "Layers" above the list of layers. A 
context menu appears with additional features to apply to the layer. 

To Change the Order of Layers. All the layers except the first are movable. Click on 
the layer and hold the mouse to drag the selected layer to the new location. 

Disable / Enable of the Layer. Click on the orange circle on the left side of the 
mask layer preview icon to toggle between visible and hidden. 



Important  
When you switch to the bottom layer - all of the top layers are off automatically. 
Hence only the current layer and all layers below are always visible.  The orange circle 
is displayed on the left side of visible layer. 

How the Layers work 

Each layer uses the previous layer as it’s starting point. In other words, each layer 
imposes the result of its processing on the previous layer. 

An exception is the use of the selected texture. In this case, the effect is simply the 
selected texture. To show previous layers through new selected texture, erase a mask 
or decrease the opacity of the layer containing a texture. Otherwise, the top opaque 
texture completely covers all the lower layers. 

How to Choose a Custom Texture as the Source Image for the Layer 

!  

By default, each top sheet effect is superimposed on the previous layer. But it is 
possible to use the selected texture as a base for a new layer instead of previous 
layer. There are 2 types of selected textures: texture from an external file (user) or 
one of the HDR file bracket. 

To choose a custom texture from a file for a layer. Click the right mouse button 
on the layer to display the context menu and from there choose the "Source Image -> 
Custom Texture..." After that, you select an image file open dialog. To control the 
texture-mapping mode, you can configure the context menu "Texture Mapping” to Fill 
the Screen or Scale to Fit. 

To select one of the HDR bracket images as layer base. Click the right mouse 
button on the layer to open the context menu, then select the "Source Image". Find 



the named image from the bracket with the names: HDR Frame 0, HDR Frame 1, HDR 
Frame 2. For convenience, the associated EV is displayed opposite each image. 

Masking Mode 

The application always runs in one of two modes - Move Image Mode or Drawing 
Mode. To switch modes use the toolbar buttons at the top: a hand and a brush. 

!  

Move Image Mode 

Move Image Mode works with the active Hand button in the top toolbar. In this mode, 
the cursor is used to move the image when in a zoomed in state. Click on the central 
image and the cursor will turn into a hand. Continue pressing the mouse button down 
and move the image until the portion of the image you want to examine is in view. In 
addition, use gestures to navigate OSX. Slide the touchpad with two fingers. 

Drawing Mode for Creating Masks 

The Drawing mode makes it possible to create a layer mask upon which a layer effect 
will be applied. In this way, you can selectively edit the image. In this mode, the 
cursor turns into a brush. Press the left mouse button on the image to begin drawing. 

When you switch to the Drawing Mode, the upper information bar is transformed into 
a mask layer drawing toolbar. 

The Left Side of the Drawing Toolbar 

!  

The icon with an eye  
Hides or shows the layer mask. If you click the eye icon, the layer mask appears over 
the image with a red translucent layer. You may also continue drawing while the layer 
mask is shown, for even more precision. 



The Clear Button  
Clears (or resets) the layer mask and the active layer becomes visible. 

Additional Features Button contains addition features related to operating with the 
layer. Button is in the form of 3 stripes and a drop-down arrow icon. It opens a 
context menu with additional options for working with the layer. 

• Invert 
Inverts any mask that you’ve created. 

• Fill  
Fills the entire layer with a mask. 

• Create Luminosity Mask 
This tool fills the current layer with a mask based on the brightness of image 
pixels.  

• Copy Mask 
Copies the current mask to the clipboard. To use this, create a new layer and 
paste it into the new layer. 

The Central Part of the Drawing Toolbar 
The image zoom percentage is displayed in the central part. To select one of the fixed 
zoom modes, click on the down arrow. In the drop down menu, select the desired 
zoom value. 

!  

The Right Side of the Drawing Toolbar 
Brush functions associated with drawing are located on the right side of the toolbar. 

Parameters of the Brush Button 
This button displays the current status of the brush, namely transparency and 
softness. Press this button and a pop-up window appears with brush painting settings: 
In this window, you can configure all the parameters of a brush drawing such as Size, 
Opacity and Softness. In the center of the grid there are various configurations of the 
brush painting preset for quick selection. 



Erasing Mode Button 
By default, when working in the Drawing Mode, you will be using a brush tool. If  you 
press the button that looks like an eraser, you will be switched into Erase mode. 
Therefore, when you paint on the layer mask, it will have the effect of erasing the 
mask. This is handy for “trimming” overspray of the mask and making your selection 
more accurate. 

Gradient Filling Tool 
Clicking on the button that looks like a grid will automatically create a Gradient Mask 
on your layer. This allows you to enhance your image very smoothly with effects only 
applied to the Gradient. Move the Gradient up, down or rotate it to suit your image. 

!  

Masking Mode: Additional Features 

• While masking or erasing, right clicking of the mouse causes a context window 
of parameter settings of the brush, and includes additional controls for pen 
pressure sensitivity. 

• Before the layer name in the Layers panel a thumbnail image of the current 
layer mask is displayed. 

• To quickly switch between masking and erasing modes, use a hot key - "X" 
• To quickly change the diameter of the brush, use hot keys "[" and "]". It is very 

convenient and greatly speeds up the work. 
• If you hold down the space bar in Drawing mode you can switch to Move the 

image mode. 



Luminosity Mask Creation and Application 

!  

Aurora HDR supports the ability to create a Luminosity Mask. This tool fills the current 
layer with a mask based on the brightness of image pixels. Thus the transparency of 
the mask corresponds to the brightness of the pixel. This is a very powerful tool to 
mask image selectively. 

To create a Luminosity Mask, right-mouse click on layer to reveal the context sensitive 
menu of the Layer. Then select "Create Luminosity Mask" from the menu to make the 
Luminosity Mask. 

Gradient Mask Filling Tool Application 
The tool allows convenient filling of the mask with a gradient. 

To activate the tool, click the tool button in the Drawing Toolbar: After that, the 
gradient boundaries image (horizontal stripes) appears on the screen. 

The bands of red indicate the following: 
• 100% opacity of mask is located in the upper strip 
• Strip transparency gradually falls to 0% from the top to the bottom. The middle 

strip is 50% of transparency. 
• 0% transparency is after the lower strip. 



!  
These strips - bands of the gradient - can be freely moved with the mouse to get a 
desired transition of the gradient. They can also be freely rotated by clicking on the 
“Angle” button and using the resulting slider. 

To apply the mask to the layer, click the “Apply” button. The mask that was configured 
by the tool appears on the layer mask. To cancel creating a gradient on the layer 
mask and exit the tool, press “Cancel.” 



Final Steps                                                        

Crop Tool 

To switch to Crop Tool Mode, choose the Scissors icon in the top toolbar or press the 
"C" key. After pressing this button, the application goes to Crop Tool Mode. 

The upper dashboard is switched to functions for cropping an image. The image is 
displayed with a grid and crop window. Tug at any of the handles on the edge of the 
cropping rectangle to resize the cropping guides. Pressing the space bar will allow you 
to move the image “behind” the cropping guides, positioning the image where 
desired. 

!  

Possible actions with Crop Window: 

• Resize. Click on one of the edges, hold down the mouse, drag the handle. 
• Move. Click inside the image crop area and hold the left mouse button to start 

dragging the image. 
• Rotate. Bring the mouse cursor outside of any corner, and when the cursor 

turns into two arrows, hold down the mouse left button and start moving the 
cursor in any direction. The image is rotated. 

Once the area that should remain after cropping is determined, click "Crop" to ensure 
that the image is cropped according to the image Crop window. To cancel this action 



press “Cancel". If the image is already cut off, but you don`t like the result, you can 
easily undo the cropping by pressing the Undo button. Hence cropping is a safe 
operation that can be easily undone. 

Saving and Exporting 

To save your work in progress, press Cmd + S” on your keyboard or choose the “File 
> Save…” menu item.  Your work is saved in its current state so that you can later 
continue from the same point. 

To save the results of your work to an image file, use the menu item work in the 
image, use the menu item File > "Export to image" or the key combination "Shift + 
Cmd + E". You can also use the menu item "Export to image..." from the "Share" 
button pop-window. 

When you export a file, you can save in a variety of file formats including JPG, TIFF, 
PNG and even PSD. Each file format has its own unique set of parameters which are 
standard. 



Extra Features                                                 

The application includes many user-friendly features to simplify your work. 

Double click on the slider name resets the value to the default.  
In most cases, double-clicking returns it to 0. 

If you press and hold the Option key and click on a slider value in the sidebar, 
moving the cursor to the left and right will let you set the values of the slider with 
high accuracy. Slider sensitivity is higher than with its normal movement. This allows 
you to fine-tune to small numeric values. 

The top histogram has triangles on the left and right sides.  

!  

To enable or disable the display mode of absolutely black pixels, click the triangle on 
the left and the histogram is clipped on the left side. Absolutely black pixels will be 
displayed in bright blue in the image. Clicking the triangle on the upper right will show 
where your image is completely white, where the histogram is clipped on the right 
side. Absolutely white pixels are displayed in red. 

Pressing the "F" button enables full-screen viewing of your imagef. This allows you 
to look at the result conveniently without the interface. Press any key to return to 
normal mode.  

The app includes a special operating mode with the sidebar. It is called "Single 
View Mode” and is accessed from the View menu. In this mode, all the tools, except 
the current one, are closed. Click on a different tool and the current one will be closed 
and the new one opened. In this mode, only one control is visible, cleaning up the 
sidebar interface significantly. 



!  

For large files or when looking at your image in an extreme zoomed-in state, a 
Navigator Window can be used. This is a special window which is hidden by default.  It 
can be displayed on the screen when you select "View -> Show Navigator" or by 
pressing "Z". In this window, you can always see the whole picture and use the visible 
portion of the image area (white rectangle) for navigation on the image. 

!  



To quickly open a folder in the Finder, where there are source files of HDR image 
bracket, obtained for the current HDR image, you can use the "File -> Show in 
Finder...” 

The background of the image can also be changed. By default it is dark gray. But it 
can be lightened, as desired. Select the menu item "View -> Background” or right-
mouse click on the image background to select a new background color for the image. 

Processed images can be easily and quickly transferred to other applications. Click on 
the "Share" button in the toolbar and select the desired application in the window that 
appears at the bottom of the section with the heading "Open In:". This will open the 
selected application with image as the current result of the Aurora HDR.  
Aurora HDR remains open. 

You can also share images to selected online communities  
and social networks if you have an account on them. 

Thank you for your attention.  

If you have questions, contact Aurora HDR 24/7 support at support@aurorahdr.com. 
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